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摘要 

肺炎疫情肆虐全球，學校因應疫情進行各項清潔工作，於是我們想研究哪種清潔方式的

效果最好。本實驗以 ImageJ作為影像分析軟體，接著設計洗手方式、清潔劑種類、洗手乳

質量、洗手液濃度及其放置多天後實驗，最後將常見清潔液用於環境上等六個變因來探討抗

菌效果。研究結果顯示洗手方式為「濕、搓、沖、捧、擦」，其中乙方式無特別限制「搓」

的動作，有較佳抗菌效果；以酒精洗手抗菌效果為佳；洗手乳質量以 1.8公克為佳；純洗手

乳為最佳清潔濃度；放置 25天後以 D組濃度(洗手乳：水=1：2)的抗菌效果為佳；在環境清

潔實驗上，不論清潔液種類皆具有抗菌效果，其中以酒精為最佳。 

 

壹、研究動機 

     新冠肺炎（2019年冠狀病毒疾病-COVID-19）肆虐全球，造成成千上萬人染疫，甚至是

死亡。各國人心惶惶，而中央疫情指揮中心也提醒民眾應該做好防疫工作，戴口罩、量體溫、

噴酒精。學校也因應疫情進行各項清潔工作，例如：使用 75％酒精消毒手部、利用漂白水

清潔桌椅、吃飯前用洗手乳洗手。而做著清潔工作的我，突然感到好奇與疑惑，到底哪種清

潔方式的抗菌效果最好呢？上網查詢過後，發現酒精、漂白水、洗手乳、肥皂等，都具有抗

菌的功效，為了更進一步探討箇中清潔方式是否有不同抗菌效果，我們開始實驗各種清潔劑

及清潔方式的抗菌效果並研究如何提升抗菌能力的方法。 

貳、實驗目的 

一、探討洗手方式對手部抗菌效果之影響。 

二、探討清潔劑的種類對手部抗菌效果之影響。 

三、探討洗手乳的質量多寡對手部抗菌效果之影響。 

四、探討洗手液的濃度對手部抗菌效果之影響。 

五、探討不同濃度洗手液放置 25天後對手部抗菌效果之影響。 

六、探討不同清潔液對環境抗菌效果之影響。 
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參、研究設備及器材 

一、材料與器材：吐司(圖 1) 、洗手乳(圖 2)、肥皂(圖 3)、酒精(圖 4)、漂白水(圖 5)、雙氧

水 (圖 6)、氨水(圖 7)、夾鏈袋(圖 8) 、C型環(圖 9)、3D列印機(圖 10) 、筆記型電腦。 

二、觀測設備：數位式游標卡尺(圖 11)、手機相機。 

三、影像分析軟體：ImageJ(圖 12)。 

   

(圖 1    吐司) (圖 2    洗手乳) (圖 3    肥皂) 

 

 

 

(圖 4    酒精) (圖 5   漂白水) (圖 6     雙氧水) 

   

(圖 7     氨水) (圖 8   夾鏈袋) (圖 9    C型環) 

 
 

 

(圖 10  3D列印機) (圖 11  數位式游標卡尺) (圖 12  ImageJ) 
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肆、研究過程或方法 

一、黴菌簡介 

名稱 絲狀真菌的俗稱 科學分類 真菌界-接合菌門 

形態 

特徵 

由菌絲跟孢子組成，黴菌的菌絲多呈分枝狀、具多個細胞核，而且繁殖迅速，其

菌絲會不斷生長及分枝聚成菌絲體呈絨毛狀，所以肉眼可以看出毛絨絨的菌落。 

黴菌的種類非常多種，不同的黴菌依照孢子的顏色就會呈現不同的顏色，像是黑

色、白色、青綠色、黃色、褐色…等都有。 

生長 

條件 

黴菌的生長有營養、溫暖及潮濕 3 個條件，適合生長在氣溫攝氏 15～20 度，且潮

濕的地方，孢子約 5-7 天就能大量生成繁殖並四散於各處。黴菌的孢子在空氣中飄

浮著，會附生到各種東西上，當生長條件適合時，會從孢子長出菌絲進行繁殖。

黴菌特別喜歡生長在含醣類或澱粉的食物上，長黴菌的食物會造成食物腐敗，有

些黴菌還能產生毒素，嚴重危害人體健康。 

二、測量黴菌覆蓋率的方式 

(一)網格面積法：計算黴菌覆蓋率以網格計算其所占面積百分比，先算出一個吐司所占的總

格子數，再記錄吐司上所生成黴菌的格子總數，即可計算出各組所生成的黴菌在吐司中

的黴菌覆蓋率。 

 (二) ImageJ分析法：以 ImageJ先算出吐司面積，再用 ImageJ計算吐司上所生的黴菌面積，

即可計算出各組所生成的黴菌在吐司中的黴菌覆蓋率。我們發現 ImageJ自由軟體計算黴

菌面積所得結果較為精密，故我們選擇以 ImageJ 自由軟體來計算黴菌覆蓋率。 

三、探究手部抗菌效果的各種變因方法 

            施測對象是八年級學生，並經師長同意利用早修或中午時間進行實驗，因受試時間短

暫，皆事先準備材料與器材以便進行施測實驗。探討各種抗菌效果的變因方法，請受試者

在洗手前先碰觸第一片吐司，吐司放到夾鏈袋中，接著以不同變因方式並請受試者測試，

在受試者將手擦乾後，再碰觸第二片吐司，吐司放到夾鏈袋中，放在相同環境下每日進行

觀察並拍照紀錄之。因黴菌生長週期約 5-7天，故主要觀察分析 7天左右的影像照片。 

(一) 洗手方式：以相同質量的肥皂，請受試者分兩組依「濕(10秒)、搓(21秒)、沖(20秒)、

捧(10秒)、擦(手部乾燥為止)」的步驟洗手，甲組在「搓」的階段以「內、外、夾、弓、

大、立、腕」的方式進行清潔步驟(圖 13)，而乙組在「搓」的階段則無限制自由發揮(圖
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14)，將洗手前(x)和洗手後(y)的吐司每日拍照記錄之。 

  
(圖 13  甲組清潔步驟) (圖 14 乙組清潔步驟) 

(二) 清潔劑種類：將同質量(4.2公克)的不同種類的清潔劑分為三組，A組肥皂 (圖 15)、B組

洗手乳 (圖 16)及 C組酒精(圖 17)，依固定洗手程序進行實驗，將洗手前(x)和洗手後(y)的

吐司每日拍照記錄之。 

   

(圖 15  A組肥皂) (圖 16  B組洗手乳) (圖 17  C組酒精) 

 (三) 洗手乳的質量多寡：以 3D列印方式印出不同高度的 C型環來控制洗手乳的質量多寡。 

1、先以數位式游標卡尺量測洗手乳相關尺寸，再以 Tinkercad 繪製 C型環的設計圖，最後

以 3D列印機印出實體 C型環。 

2、量測不同高度 C型環所按壓出來的洗手乳質量，測量結果如下表(表 1)。 

表 1    不同高度 C型環所按壓的洗手乳質量 

C型環高度 0.7cm 0.6cm 0.5cm 0.4cm 0.3cm 0.2cm 0.1cm 

第 1次測量(公克) 0.8 1.1 1.4 1.7 2.7 3.0 3.1 

第 2次測量(公克) 0.9 1.1 1.2 1.8 2.7 3.0 3.1 

第 3次測量(公克) 1.0 1.1 1.3 1.9 2.7 2.9 3.1 

第 4次測量(公克) 0.9 1.1 1.2 1.8 2.7 3.0 3.1 

第 5次測量(公克) 0.9 1.0 1.2 1.8 2.7 3.1 3.1 

平均每次按壓量(公克) 0.9 1.1 1.3 1.8 2.7 3.0 3.1 

 3、依平均每次按壓量結果，將不同質量洗手乳分為四組，分別為 4.2公克洗手乳(未套用

C型環，A組如圖 18)、2.7公克洗手乳(C型環高度 0.3公分，B組如圖 19)、1.8公克洗手

乳(C型環高度 0.4公分，C組如圖 20)及 0.9公克洗手乳(C型環高度 0.7公分，D組如圖

21)，依固定洗手程序實驗，將洗手前(x)和洗手後(y)的吐司每日拍照記錄。 
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(圖 18  A組實驗/ 

質量 4.2公克) 

(圖 19  B組質量/ 

質量 2.7公克) 

(圖 20  C組質量/ 

質量 1.8公克) 

(圖 21  D組質量/ 

質量 0.9公克) 

(四) 洗手液的濃度： 

1、製作不同濃度的洗手液(圖 22)：利用電子天平秤量洗手乳與水的質量，分別在四個壓

瓶中裝入 A組純洗手乳 30公克、B組洗手乳 40公克與 20公克水、C組洗水乳 30公克與

30公克水、D組洗水乳 20公克與 40公克水，最後將四瓶洗手液搖晃使其均勻。 

 

(圖 22  A-純洗手乳，B-洗手乳：水=2：1，C-洗手乳：水=1：1，D-洗手乳：水=1：2) 

2、依固定洗手程序實驗，將洗手前(x)和洗手後(y)的吐司每日拍照記錄之。 

(五)不同濃度洗手液放置 25天後對手部抗菌效果之實驗：將實驗(四)中不同濃度的洗手液放

置 25天後，再次進行實驗。依固定洗手程序實驗，將洗手前(x)和洗手後(y)的吐司每日拍

照記錄之。 

四、探究不同清潔液對環境抗菌效果的變因方法 

(一) 清潔液種類：氨水、雙氧水、漂白水、洗手乳、肥皂、常溫水、冰水、熱水、酒精。 

(二)實驗環境地點：以教室旁樓梯轉角處的欄杆進行實驗。 

 1、將欄杆以 30cm為一區段，每個區段運用一種清潔液進行清潔。 

 2、以清潔液清潔後，先以一張衛生紙將欄杆擦拭乾淨，再以一張衛生紙將欄杆擦乾。 

 3、戴上滅菌式手套拿取吐司觸碰欄杆 5秒，再將吐司放入夾鏈袋封存，每日拍照記錄。 

五、計算黴菌覆蓋率：以影像分析軟體 ImageJ打開實驗影像進行處理。 

A B C D 
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1、定比例尺：Straight → Analyze → Set Scale → Known distance (已知長度，單位：cm)。 

     以直線畫出已知長度(夾鏈袋頂部長度為 14.00cm)，並設單位為公分(原單位為像素)。 

2、影像照片裁剪適當大小：Rectangle → Image → Crop。 

     以矩形工具框選範圍，將影像照片多餘的部份進行裁切，使影像照片有適當大小。 

3、標示比例尺：Analyze → Tools → Scale Bar(比例尺 1cm，標示於左下方，顏色藍色)。 

4、新增圖層區：Analyze → Tools → ROI Manager → Add(新增) → Rename(重新命名)。 

5、計算面積： 

(1)吐司面積：以多邊形工具框選吐司範圍後，Analyze → Measure測量選取範圍的面積。 

(2)黴菌面積：以筆刷工具點畫出黴菌範圍後，Analyze → Measure測量點選範圍的面積。 

6、計算黴菌覆蓋率：黴菌覆蓋率 =
黴菌面積

吐司面積
× 100%。 

7、將處理後的影像照片存檔後，使用於實驗報告影像照片(圖 23)及 Excel檔紀錄(圖 24)。 

  
(圖 23     使用 ImageJ分析覆蓋率之情形) (圖 24     使用 ImageJ記錄覆蓋率之情形) 
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伍、實驗結果 

一、探討洗手方式對手部抗菌效果之影響 

控制變因 操縱變因 應變變因 

◆吐司一片 

◆肥皂的質量(4.2公克) 

◆盛裝吐司的夾鏈袋(密封) 

◆環境因素 (同一洗手台) 

◆洗手方式： 

    「濕、搓、沖、捧、擦」， 

    在「搓」的階段，分為 

    甲、乙兩組 

◆吐司發霉情形 

        以八年級 6位學生為受試者，分為甲乙兩組各 3人，甲組在「搓」的階段以「內、外、

夾、弓、大、立、腕」的方式進行清潔步驟，而乙組實驗則無限制方式。將洗手前吐司放到

夾鏈袋中記為「x」，受試者將手擦乾後，將洗手後吐司放到夾鏈袋中記為「y」，放在相同環

境下每日進行觀察並拍照記錄之(表 2)。 

 

表 2    不同洗手方式對手部抗菌效果之影像結果 

組別 1 - x 1 - y 2 - x 2 - y 3 - x 3 - y 

D

5 

甲 

      

乙 

      

D

6 

甲 

      

乙 

      

D

7 

甲 

      

乙 
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        我們發現甲、乙兩組不論洗手前或洗手後皆在第六日開始發霉，且第八日發霉情況嚴重，

接下來以 ImageJ進一步分析第八日的黴菌覆蓋率(表 3)。 

表 3    不同洗手方式在第八日對手部抗菌效果之影像分析結果 

D

8 

甲 

      

乙 

      

組別 1 2 3 

甲- x 

   
黴菌覆蓋率 1.38% 5.12% 3.97% 

甲- y 

   
黴菌覆蓋率 2.90% 0.73% 3.09% 

 1 2 3 

乙- x 

   
黴菌覆蓋率 0.15% 0.80% 3.26% 

乙- y 

   
黴菌覆蓋率 0.52% 0.53% 0.75% 
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 二、探討清潔劑的種類對手部抗菌效果之影響 

控制變因 操縱變因 應變變因 

◆清潔劑質量(4.2公克) 

◆盛裝吐司的夾鏈袋(密封) 

◆環境因素 (如：吐司、洗手台) 

◆洗手程序 

◆清潔劑種類： 

    肥皂、洗手乳、酒精 
◆吐司發霉情形 

       施測對象是八年級 9位學生，分為肥皂、洗手乳及酒精三組不同清潔劑各 3人，以固定

洗手程序進行實驗。將洗手前吐司放到夾鏈袋中記為「x」，受試者將手擦乾後，將洗手後吐

司放到夾鏈袋中記為「y」，放在相同環境下每日進行觀察並拍照記錄之(表 4)。 

表 4    不同清潔劑對手部抗菌效果之影像結果 

組別 甲-1- X 甲-1-Y 甲-2- X 甲-2-Y 甲-3-X 甲-3-Y 

D

6 

肥

皂 

      

洗

手

乳 
      

酒

精 

      

D

8 

肥

皂 

      

洗

手

乳 
      

酒

精 

      

        我們發現三組洗手前的吐司在第六日開始發霉，而洗手後三組在第六日開始發霉，肥皂

組發霉斑點較多，洗手乳組發霉斑點排第二，而酒精只有長少許霉菌。且第八日發霉情況增

長許多，接下來以 ImageJ進一步分析第八日的黴菌覆蓋率(表 5)。 
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表 5    不同種類清潔劑在第八日對手部抗菌效果之影像分析結果 

 

  

組別 1 2 3 

肥皂- x 

   
黴菌覆蓋率 1.38% 5.12% 3.97% 

肥皂- y 

   
黴菌覆蓋率 2.90% 0.73% 3.09% 

洗手乳- x 

   
黴菌覆蓋率 1.67% 3.24% 1.22% 

洗手乳- y 

   
黴菌覆蓋率 1.66% 1.81% 1.53% 

酒精- x 

   
黴菌覆蓋率 1.21% 7.98% 2.52% 

酒精- y 

   
黴菌覆蓋率 0.18% 1.06% 1.46% 
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三、探討洗手乳的質量多寡對手部抗菌效果之影響 

控制變因 操縱變因 應變變因 

◆清潔劑種類(洗手乳) 

◆盛裝吐司的夾鏈袋(密封) 

◆洗手程序、環境因素 (同一洗手台) 

◆洗手乳質量 ◆吐司發霉情形 

        以八年級 12位學生為受試者，分為不同質量的洗手乳：A組 4.2公克、B組 2.7公克、

C組 1.8公克及 D組 0.9公克共四組各 3人，以固定洗手程序進行實驗。將洗手前吐司放到

夾鏈袋中記為「x」，受試者將手擦乾後，將洗手後吐司放到夾鏈袋中記為「y」，放在相同環

境下每日進行觀察並拍照記錄之(表 6)。 

表 6    不同洗手乳質量對手部抗菌效果之影像結果 

組別 1 - x 1 - y 2 - x 2 - y 3 - x 3 - y 

D

1

2 

A 

      

B 

      

C 

      

D 

      

D

1

6 

A 

      

B 
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        我們發現四組洗手前的吐司在第十二日開始發霉，而四組洗手後在第十二日開始發霉，

且洗手前的發霉情形大多比洗手後的嚴重，而在第十六日發霉情況增長許多，接下來以

ImageJ進一步分析第十六日的黴菌覆蓋率(表 7)。 

表 7    不同洗手乳質量在第十六日對手部抗菌效果之影像分析結果 

組別 1 2 3 

A組 4.2公克- x 

   

黴菌覆蓋率 1.27% 2.10% 4.34% 

A組 4.2公克-  y 

   

黴菌覆蓋率 1.74% 2.74% 3.22% 

B組 2.7公克- x 

   

黴菌覆蓋率 1.58% 1.55% 1.32% 

B組 2.7公克- y 

   

黴菌覆蓋率 0.42% 6.14% 0.93% 

C組 1.8公克- x 

   

黴菌覆蓋率 2.15% 2.27% 1.81% 
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表 7    不同洗手乳質量在第十六日對手部抗菌效果之影像分析結果(續) 

 

四、探討洗手液的濃度對手部抗菌效果之影響 

控制變因 操縱變因 應變變因 

◆吐司一片 

◆洗手液量 

◆盛裝吐司的夾鏈袋(密封) 

◆洗手程序環境因素 (同一洗手台) 

◆洗手液濃度： 

 A組純洗手乳、 

 B組洗手乳：水=2：1、 

 C組洗手乳：水=1：1、 

 D組洗手乳：水=1：2。 

◆吐司發霉情形 

施測對象是八年級 12位學生，分為不同濃度的洗手液：A組、B組、C組及 D組共四

組各 3人，以固定洗手程序進行實驗。將洗手前的吐司記為「x」，受試者將手清潔擦乾後，

洗手後的吐司記為「y」，放在同環境下每日進行觀察並拍照記錄之(表 8)。 

  

組別 1 2 3 

C組 1.8公克- y 

   

黴菌覆蓋率 1.02% 0.87% 1.36% 

D組 0.9公克- x 

   

黴菌覆蓋率 1.45% 1.48% 0.28% 

D組 0.9公克- y 

   

黴菌覆蓋率 1.04% 3.00% 1.78% 
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表 8    不同濃度的洗手液對手部抗菌效果之影像結果 

        我們發現四組洗手前的吐司在第十二日開始發霉，而洗手後 B、C、D三組在第十二日

開始發霉，A組純洗手乳在第十三日開始發霉；洗手前的發霉情形大多比洗手後的嚴重，而

在第十六日發霉情況增長許多，接下來以 ImageJ進一步分析第十六日的黴菌覆蓋率(表 9)。 
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表 9    不同濃度的洗手液在第十六日對手部抗菌效果之影像分析結果 

  

組別 1 2 3 

A組- x 

   
黴菌覆蓋率 2.37% 0.99% 1.84% 

A組- y 

   
黴菌覆蓋率 0.40% 0.27% 0.61% 

B組- x 

   
黴菌覆蓋率 0.95% 0.95% 0.35% 

B組- y 

   
黴菌覆蓋率 2.16% 1.96% 0.35% 

C組- x 

   
黴菌覆蓋率 1.06% 2.53% 1.03% 

C組- y 

   
黴菌覆蓋率 1.18% 1.57% 0.86% 
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表 9    不同濃度的洗手液在第十六日對手部抗菌效果之影像分析結果(續) 

 

五、探討不同濃度洗手液放置 25天後對手部抗菌效果之影響 

控制變因 操縱變因 應變變因 

◆吐司一片、洗手液量 

◆盛裝吐司的夾鏈袋(密封) 

◆洗手程序環境因素 (同一洗手台) 

◆洗手液放置 25天後 

A組純洗手乳、  

B組洗手乳：水=2：1、 

C組洗手乳：水=1：1、 

D組洗手乳：水=1：2。 

◆吐司發霉情形 

施測對象是八年級 12位學生，分為不同濃度的洗手液放置 25天後：A組、B組、C組

及 D組共四組各 3人，以固定洗手程序進行實驗。將洗手前的吐司記為「x」，受試者將手擦

乾後，洗手後的吐司記為「y」，放在同環境下進行觀察並拍照記錄之(表 10)。 

  

組別 1 2 3 

D組- x 

   
黴菌覆蓋率 7.98% 8.32% 3.62% 

D組- y 

   
黴菌覆蓋率 0.89% 1.56% 0.63% 
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表 10    不同濃度洗手液放置 25天後對手部抗菌效果之影像結果 

        我們發現其中 A組第一位受試者洗手後的吐司在第四日開始發霉，而其他組洗手前、

洗手後的吐司在第七日開始發霉，且洗手前的發霉情形大多比洗手後的嚴重，而在第十日發

霉情況增長許多，接下來以 ImageJ進一步分析第十日的黴菌覆蓋率(表 11)。 
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表 11    不同濃度的洗手液放置 25天後在第十日對手部抗菌效果之影像分析結果 

組別 1 2 3 

A組- x 

   

黴菌覆蓋率 6.83% 1.35% 0.50% 

A組- y 

   

黴菌覆蓋率 26.83% 0.85% 1.52% 

B組- x 

   

黴菌覆蓋率 0.19% 1.53% 0.25% 

B組- y 

   

黴菌覆蓋率 11.03% 5.49% 0.19% 

C組- x 

   

黴菌覆蓋率 0.85% 0.83% 3.21% 

C組- y 

   

黴菌覆蓋率 0.64% 0.83% 0.29% 
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表 11    不同濃度的洗手液放置 25天後在第十日對手部抗菌效果之影像分析結果(續) 

 

六、探討不同清潔液對環境抗菌效果之影響 

控制變因 操縱變因 應變變因 

◆吐司一片 

◆清潔劑量 

◆盛裝吐司的夾鏈袋(密封) 

◆清潔程序環境因素 

◆清潔液種類： 

氨水、雙氧水、漂白水、 

洗手乳、肥皂、常溫水、 

冰水、熱水、酒精 

◆吐司發霉情形 

在同一處樓梯欄杆，分為不同種類的清潔液：氨水、雙氧水、漂白水、洗手乳、肥皂、

常溫水、冰水、熱水、酒精、未處理及對照組共 11組，以固定清潔程序進行實驗，並於清

潔擦乾後，然後以吐司碰觸五秒，在相同環境下每日觀察並拍照記錄(表 12)。 

  

組別 1 2 3 

D組- x 

   

黴菌覆蓋率 4.22% 3.90% 6.23% 

D組- y 

   

黴菌覆蓋率 1.33% 0.45% 0.28% 
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表 12    不同清潔液對環境抗菌效果之影像結果 

D4 

對照組 未處理 氨水 雙氧水 漂白水 洗手乳 

      
肥皂 常溫水 冰水 熱水 酒精 

 

     

D5 

對照組 未處理 氨水 雙氧水 漂白水 洗手乳 

      
肥皂 常溫水 冰水 熱水 酒精 

 

     

D6 

對照組 未處理 氨水 雙氧水 漂白水 洗手乳 

      
肥皂 常溫水 冰水 熱水 酒精 

 

     

D7 

對照組 未處理 氨水 雙氧水 漂白水 洗手乳 

      
肥皂 常溫水 冰水 熱水 酒精 

 

     

D8 

對照組 未處理 氨水 雙氧水 漂白水 洗手乳 

      
肥皂 常溫水 冰水 熱水 酒精 
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        我們發現未處理及雙氧水的吐司在第四日開始發霉，氨水、肥皂及常溫水的吐司在第五

日開始發霉，漂白水、洗手乳及冰水的吐司在第六日開始發霉，而對照組、熱水及酒精的吐

司在第七日開始發霉。在第八日發霉情況增長，以 ImageJ進一步分析黴菌覆蓋率(表 13)。 

表 13    不同清潔液在第八日對環境抗菌效果之影像分析結果 

組別 對照組 未處理 氨水 

影像 

分析結果 

   
黴菌覆蓋率 1.07% 27.85% 11.18% 

組別 雙氧水 漂白水 洗手乳 

影像 

分析結果 

   
黴菌覆蓋率 9.66% 11.40% 8.17% 

組別 肥皂 常溫水 冰水 

影像 

分析結果 

   
黴菌覆蓋率 3.17% 3.38% 5.61% 

組別 熱水 酒精 

 
影像 

分析結果 

 
 

黴菌覆蓋率 3.74% 2.42% 
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陸、討論 

一、洗手方式對手部抗菌效果之影響 

        經實驗發現，甲、乙兩種洗手方式不論洗手前或洗手後皆在第六日開始發霉，且第八日

發霉情況嚴重，接下來以 ImageJ進一步分析第八日的黴菌覆蓋率(圖 25、圖 26)。 

  

(圖 25    甲洗手方式對手部抗菌效果之比較) (圖 26    乙洗手方式對手部抗菌效果之比較) 

        經實驗結果分析，甲洗手前的黴菌覆蓋率為 1.38%至 5.12%，甲洗手方式的黴菌覆蓋率

為 0.73%至 3.09%；乙洗手前的黴菌覆蓋率為 0.15%至 3.26%，乙洗手方式的黴菌覆蓋率為

0.52%至 0.75%。我們發現洗手後的黴菌覆蓋率普遍低於洗手前，且乙洗手方式的黴菌覆蓋

率皆低於甲。 

二、清潔劑的種類對手部抗菌效果之影響 

        我們發現三組洗手前的吐司在第六日開始發霉，而洗手後三組在第六日開始發霉，且第

八日發霉情況增長許多，接下來以 ImageJ進一步分析第八日的黴菌覆蓋率 (圖 27、圖 28、

圖 29)。 

 

(圖 27    肥皂對手部抗菌效果之比較) 
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(圖 28    洗手乳對手部抗菌效果之比較) 

 

(圖 29    酒精對手部抗菌效果之比較) 

        經實驗結果分析，肥皂洗手前的黴菌覆蓋率為 1.38%至 5.12%，肥皂洗手後的黴菌覆蓋

率為 0.73%至 3.09%；洗手乳洗手前的黴菌覆蓋率為 1.22%至 3.24%，洗手乳洗手後的黴菌

覆蓋率為 1.53%至 1.81%；酒精洗手前的黴菌覆蓋率為 1.21%至 7.98%，酒精洗手後的黴菌

覆蓋率為 0.18%至 1.46%。我們經實驗結果分析得知洗手後的黴菌覆蓋率普遍低於洗手前，

且黴菌覆蓋率：酒精＜洗手乳＜肥皂。 

三、洗手乳的質量多寡對手部抗菌效果之影響 

        我們發現四組洗手前的吐司在第十二日開始發霉，而洗手後四組在第十二日開始發霉，

且第十六日發霉情況增長許多，而在第十六日發霉情況增長許多，接下來以 ImageJ進一步

分析第十六日的黴菌覆蓋率(圖 30、圖 31、圖 32、圖 33)。 

1.67%

3.24%

1.22%

1.66%

1.81%
1.53%

0.00%

0.50%

1.00%

1.50%

2.00%

2.50%

3.00%

3.50%

1 2 3

黴

菌

覆

蓋

率

受試者

B洗手乳對手部抗菌效果之影響 B前 B洗手乳

1.21%

7.98%

2.52%

0.18%

1.06% 1.46%

0.00%
0.50%
1.00%
1.50%
2.00%
2.50%
3.00%
3.50%
4.00%
4.50%
5.00%
5.50%
6.00%
6.50%
7.00%
7.50%
8.00%
8.50%

1 2 3

黴

菌

覆

蓋

率

受試者

C酒精對手部抗菌效果之影響 C前 C酒精



23 

 

(圖 30    4.2公克洗手乳對手部抗菌效果之比較) 

 

(圖 31    2.7公克洗手乳對手部抗菌效果之比較) 

 

(圖 32   1.8公克洗手乳對手部抗菌效果之比較) 

 

(圖 33   0.9公克洗手乳對手部抗菌效果之比較) 

        經實驗結果分析，A組洗手前的黴菌覆蓋率為 1.27%至 4.34%，A組 4.2公克洗手乳洗

手後的黴菌覆蓋率為 1.74%至 3.22%；B組洗手前的黴菌覆蓋率為 1.32%至 1.58%，B組 2.7
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公克洗手乳洗手後的黴菌覆蓋率為 0.42%至 6.14%；C組洗手前的黴菌覆蓋率為 1.81%至

2.27%，C組 1.8公克洗手乳洗手後的黴菌覆蓋率為 0.87%至 1.36%；D組洗手前的黴菌覆蓋

率為 0.28%至 1.48%，D組 0.9公克洗手乳洗手後的黴菌覆蓋率為 1.04%至 3.00%。我們發現

C組 1.8公克洗手乳洗手後的黴菌覆蓋率普遍低於洗手前，各組洗手後的黴菌覆蓋率：C組

1.8公克洗手乳＜B組 2.7公克洗手乳＜D組 0.9公克洗手乳＜A組 4.2公克洗手乳。 

四、洗手液的濃度對手部抗菌效果之影響 

        我們發現四組洗手前的吐司在第十二日開始發霉，而洗手後 B、C、D三組在第十二日

開始發霉，A組純洗手乳在第十三日開始發霉；洗手前的發霉情形大多比洗手後的嚴重，而

在第十六日發霉情況增長許多，接下來以 ImageJ進一步分析第十六日的黴菌覆蓋率(圖 34、

圖 35、圖 36、圖 37)。 

 

(圖 34   A純洗手乳對手部抗菌效果之比較) 

 

(圖 35   B濃度對手部抗菌效果之比較) 

 

(圖 36   C濃度對手部抗菌效果之比較) 

 

(圖 37   D濃度對手部抗菌效果之比較) 
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黴菌覆蓋率為 0.27%至 0.61%；B組洗手前的黴菌覆蓋率為 0.35%至 0.95%，B組濃度(洗手

乳：水=2：1)洗手後的黴菌覆蓋率為 0.35%至 2.16%；C組洗手前的黴菌覆蓋率為 1.03%至

2.53%，C組濃度(洗手乳：水=1：1)洗手後的黴菌覆蓋率為 0.86%至 1.57%；D組洗手前的

黴菌覆蓋率為 3.62%至 8.32%，D組濃度(洗手乳：水=1：2)洗手後的黴菌覆蓋率為 0.63%至

1.56%。我們發現 A組純洗手乳及 D組濃度(洗手乳：水=1：2)洗手後的黴菌覆蓋率皆低於洗

手前，各組洗手後的黴菌覆蓋率：A組純洗手乳＜D組濃度(洗手乳：水=1：2)＜C組濃度

(洗手乳：水=1：1)＜B組濃度(洗手乳：水=2：1)。 

五、不同濃度洗手液放置 25天後對手部抗菌效果之影響 

我們發現其中 A組第一位受試者洗手後的吐司第四日開始發霉，而其洗手前、洗手後

的吐司在第七日開始發霉，且洗手前的發霉情形大多比洗手後的嚴重，而在第十日發霉情況

增長許多，接下來以 ImageJ進一步分析第十日的黴菌覆蓋率(圖 38、圖 39、圖 40、圖 41)。 

 

(圖 38   A放置 25天後對抗菌效果之比較) 

 

(圖 39   B放置 25天後對抗菌效果之比較) 

 

(圖 40   C放置 25天後對菌效果之比較) 

 

(圖 41   D放置 25天後對抗菌效果之比較) 

經實驗結果分析，A組洗手前的黴菌覆蓋率為 0.50%至 6.83%，A組純洗手乳放置 25天
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0.50%

26.83%
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後洗手後的黴菌覆蓋率為 0.85%至 26.83%；B組洗手前的黴菌覆蓋率為 0.25%至 1.53%，B

組濃度(洗手乳：水=2：1) 放置 25天後洗手後的黴菌覆蓋率為 0.19%至 11.03%；C組洗手前

的黴菌覆蓋率為 0.83%至 3.21%，C組濃度(洗手乳：水=1：1) 放置 25天後洗手後的黴菌覆

蓋率為 0.29%至 0.83%；D組洗手前的黴菌覆蓋率為 3.90%至 6.23%，D組濃度(洗手乳：水

=1：2) 放置 25天後洗手後的黴菌覆蓋率為 0.28%至 1.33%。我們發現在放置 25天後的 D組

濃度(洗手乳：水=1：2) 洗手後的黴菌覆蓋率皆低於洗手前 ，C組濃度(洗手乳：水=1：1) 洗

手後的黴菌覆蓋率普遍低於洗手前，分析各組洗手後的黴菌覆蓋率： C組濃度(洗手乳：水

=1：1) ＜ D組濃度(洗手乳：水=1：2) ＜ B組濃度(洗手乳：水=2：1) ＜ A組純洗手乳。 

六、不同清潔液對環境抗菌效果之影響 

        我們發現未處理及雙氧水的吐司在第四日開始發霉，氨水、肥皂及常溫水的吐司在第五

日開始發霉，漂白水、洗手乳及冰水的吐司在第六日開始發霉，而對照組、熱水及酒精的吐

司在第七日開始發霉。在第八日發霉情況增長，以 ImageJ分析其黴菌覆蓋率(圖 42)。 

 

(圖 42   不同清潔液對環境抗菌效果之比較) 

經結果分析，對照組(純吐司)的黴菌覆蓋率為 1.07%，未處理直接覆蓋樓梯欄杆的黴菌

覆蓋率為 27.85%，氨水的黴菌覆蓋率為 11.18%，雙氧水的黴菌覆蓋率為 9.66%，漂白水的

黴菌覆蓋率為 11.40%，洗手乳的黴菌覆蓋率為 8.17%，肥皂的黴菌覆蓋率為 3.17%，常溫水

的黴菌覆蓋率為 3.38%，冰水的黴菌覆蓋率為 5.61%，熱水的黴菌覆蓋率為 3.74%，酒精的

黴菌覆蓋率為 2.42%。我們發現不論清潔液的種類在清潔後的黴菌覆蓋率普遍低於清潔前，

各組的黴菌覆蓋率：酒精＜肥皂＜常溫水＜熱水＜冰水＜洗手乳＜雙氧水＜氨水＜漂白水。 
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柒、結論 

一、洗手方式對手部抗菌效果之影響 

        洗手方式為「濕、搓、沖、捧、擦」，甲方式在「搓」的階段以「內、外、夾、弓、大、

立、腕」，其黴菌覆蓋率為 0.73%至 3.09%；而乙方式則無特別限制動作，其黴菌覆蓋率為

0.52%至 0.75%，乙洗手方式的黴菌覆蓋率皆低於甲，由此可推知，洗手方式只要充分搓洗

皆可達到清潔手心之效果。另外從本次實驗中發現，洗手後的吐司比洗手前的吐司易發霉，

推測是因為洗手後沒有擦乾而有潮濕環境易滋生黴菌。 

二、清潔劑的種類對手部抗菌效果之影響 

肥皂洗手後的黴菌覆蓋率為 0.73%至 3.09%，洗手乳洗手後的黴菌覆蓋率為 1.53%至

1.81%，酒精洗手後的黴菌覆蓋率為 0.18%至 1.46%，經實驗結果分析得知洗手後的黴菌覆

蓋率普遍低於洗手前，且黴菌覆蓋率：酒精＜洗手乳＜肥皂，故推薦採「濕洗手(以洗手乳

或肥皂)」擦乾後，再以「酒精」乾洗手；若在外水源不便，以酒精清潔的效果也很不錯。 

三、洗手乳的質量多寡對手部抗菌效果之影響 

4.2公克洗手乳洗手後的黴菌覆蓋率為 1.74%至 3.22%，2.7公克洗手乳洗手後的黴菌覆

蓋率為 0.42%至 6.14%，1.8公克洗手乳洗手後的黴菌覆蓋率為 0.87%至 1.36%，0.9公克洗

手乳洗手後的黴菌覆蓋率為 1.04%至 3.00%。我們發現不同質量洗手乳的洗手後黴菌覆蓋率：

1.8公克＜ 2.7公克＜ 0.9公克＜ 4.2公克，故可知抗菌效果不會因洗手乳質量愈多而效果愈

好，以本實驗結果推薦「1.8公克」為較佳的洗手乳質量。 

在經濟效益上，一瓶洗手乳質量為 1000公克，若依原設計按壓一次為 4.2公克，約可使

用 238.0次；若在洗手乳瓶頸扣上本實驗所設計高度 0.4cm的 C型環，一次按壓量為 1.8公

克，則可使用 555.5次，約為原設計的 2.3倍，由實驗可知，抗菌效果更佳且實惠節約。 

四、洗手液的濃度對手部抗菌效果之影響 

A組純洗手乳洗手後的黴菌覆蓋率為 0.27%至 0.61%，B組濃度(洗手乳：水=2：1)洗手

後的黴菌覆蓋率為 0.35%至 2.16%，C組濃度(洗手乳：水=1：1)洗手後的黴菌覆蓋率為

0.86%至 1.57%，D組濃度(洗手乳：水=1：2)洗手後的黴菌覆蓋率為 0.63%至 1.56%。我們

發現 A組純洗手乳及 D組濃度(洗手乳：水=1：2)洗手後的黴菌覆蓋率皆低於洗手前，且以
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A組純洗手乳洗手後的菌覆蓋率最低，故以純洗手乳洗手的清潔濃度最佳；若有加水稀釋之

需求，建議可用 D組濃度(洗手乳：水=1：2)。 

五、不同濃度洗手液放置 25天後對手部抗菌效果之影響 

A組純洗手乳放置 25天後洗手後的黴菌覆蓋率為 0.85%至 26.83%，B組濃度(洗手乳：

水=2：1) 放置 25天後洗手後的黴菌覆蓋率為 0.19%至 11.03%，C組濃度(洗手乳：水=1：1) 

放置 25天後洗手後的黴菌覆蓋率為 0.29%至 0.83%，D組濃度(洗手乳：水=1：2) 放置 25天

後洗手後的黴菌覆蓋率為 0.28%至 1.33%，我們發現在放置 25天後以 D組濃度(洗手乳：水

=1：2) 及 C組濃度(洗手乳：水=1：1)洗手後的抗菌效果較佳。 

六、不同清潔液對環境抗菌效果之影響 

對照組(純吐司)的黴菌覆蓋率為 1.07%，未處理直接覆蓋樓梯欄杆的黴菌覆蓋率為

27.85%，其餘各組清潔後的黴菌覆蓋率為在 2.42%至 11.40%，皆低於未處理直接覆蓋樓梯

欄杆的黴菌覆蓋率，故不論清潔液種類皆具有抗菌效果，其中以酒精為最佳。 
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【評語】032910  

本作品之研究主題取材平易，解決生活中問題，而實驗過程

用心，團隊合作表現優異，研究題目具趣味性與實用性，研究中

對因變數和應變數有清楚的敘述。內容以吐司片上的黴菌覆蓋率

變化值來評估清潔方式的效果。實驗探討洗手方式、清潔劑的種

類、洗手乳的質量、洗手液的濃度、放置 25 天洗手液、不同清潔

液對環境抗菌效果之影響。整體來看為一個具可應用概念的研

究，利用中學生可執行的實驗方法，以科學步驟回答洗手方式、

清潔劑種類、洗手乳量、洗手乳濃度手部抗菌力以及環境抗菌力

的影響。以下建議提供持續研究： 

1. 建議針對黴菌覆蓋率的背景實驗或是空白實驗所得方法準

確性多嘗試，另外本實驗量測的是黴菌，對細菌、病毒是

否具有同等效果，仍有討論空間。 

2. 應同時以觀察的改變量(而非只探討洗手後的數值)來作分

析。 

3. 在這個實驗中受試者的條件很可能嚴重影響結果，例如在

洗手液濃度的結果中可看出受試者在洗手前的情形會影響

洗手的效果。 

4. 各組樣本僅三人，統計上較沒有意義，而實驗需多做重

複，以確定再現性與統計正確性。 



5. 疫情議題提出有效清潔潔淨方式，其中洗手乳加水實驗雖

仍有潔淨效能，根據報導因洗手乳大都含有防腐劑，因此

加水造成稀釋，有可能增加細菌滋生的機率，此須詳加注

意，此外稀釋過的洗手乳會相分離，需釐清未來使用潔淨

之可能性。 

032910-評語 
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作品標題：「潔」我所能，「淨」你所想！
—探討不同清潔方式之抗菌效果及其相關研究

組 別：國中

科 別：生活與應用科學科(2)( 環保與民生)

中華民國第61屆中小學科學展覽會



探討研究問題：

一、探討洗手方式對手部抗菌效果之影響。

二、探討清潔劑的種類對手部抗菌效果之影響。

三、探討洗手乳的質量多寡對手部抗菌效果之影響。

四、探討洗手液的濃度對手部抗菌效果之影響。

五、探討不同濃度洗手液放置25天後對手部抗菌效果之影響。

六、探討不同清潔液對環境抗菌效果之影響。

前言



研究方法-實驗

實驗一：洗手方式(濕搓沖捧擦) 實驗二：清潔劑種類

實驗三：洗手乳質量
實驗四：洗手液(洗手乳：水)濃度
實驗五：不同濃度洗手液放置25天後

實驗六：清潔劑種類
實驗組：氨水、雙氧水、漂白水、洗手乳、肥皂、

常溫水、冰水、熱水、酒精
對照組：未碰欄杆、未處理

4.2克 2.7克 1.8克 0.9克

肥皂 洗手乳 酒精

純洗手
乳

2：1 1：1 1：2



拍照

研究方法- ImageJ 計算黴菌覆蓋率

Step 2
定比例尺

Step 3
裁切大
小

Step 4
標示比例尺

Step 1
拍照

Step 5
使用圖層區

Step 6_1
計算吐司面

積

Step 6_2
計算黴菌面積

Step 6_3
Measure

測量點選面積

Step 6_1
黴菌覆蓋圖片

Step 6_2
黴菌覆蓋數據

Step 6_3
計算黴菌覆蓋率

黴菌覆蓋率 =
黴菌面積

吐司面積
× 𝟏𝟎𝟎%



甲方式在「搓」的階段以「內、外、夾、弓、大、立、腕」，其黴菌覆蓋率為0.73%至3.09%；而乙方式則無特別限
制動作，其黴菌覆蓋率為0.52%至0.75%，乙洗手方式的黴菌覆蓋率皆低於甲。

研究結果_一、洗手方式

 洗手方式對手部抗菌效果之影響

甲黴菌覆蓋率為0.73％至3.09％，乙為0.52％至0.75％，

乙洗手方式黴菌覆蓋率皆低於甲。



研究結果_二、清潔劑種類

 清潔劑的種類對手部抗菌效果之影響

A黴菌覆蓋率0.73％至3.09％，B黴菌覆蓋率1.53％至1.81％，

C黴菌率0.18％至1.46％，酒精清潔手部的黴菌覆蓋率較低。



 洗手乳質量多寡對手部抗菌效果之影響

研究結果_三、洗手乳質量

※黴菌覆蓋率：
C組1.8公克洗手乳＜
B組2.7公克洗手乳＜
D組0.9公克洗手乳＜
A組4.2公克洗手乳。

※由實驗可知:
按壓越多的洗手乳，
抗菌效果並不是就越
好，
這裡以1.8公克的洗手乳
抗菌效果最佳，而且可
使用的次數較多。



研究結果_四、洗手液濃度

 洗手液濃度對手部抗菌效果之影響

※黴菌覆蓋率：
A組純洗手乳＜
D組濃度(洗手乳：水=1：2)＜
C組濃度(洗手乳：水=1：1)＜
B組濃度(洗手乳：水=2：1)。

※由實驗可知:
純洗手乳抗菌效果最佳，
若有加水稀釋之需求，
則建議D組洗手乳與水的
質量比為1:2的洗手液。



研究結果_五、不同濃度洗手液放置25天後

※黴菌覆蓋率 ： C組 ＜ D組 ＜ B組 ＜ A組
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研究結果_六、不同清潔液
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黴菌覆蓋率

※黴菌覆蓋率：酒精＜肥皂＜常溫水＜熱水＜冰水＜洗手乳＜雙氧水＜氨水＜漂白水



1、無限制洗手方式的黴菌覆蓋率皆低於「內、外、夾、弓、大、立、腕」，
→洗手方式只要充分搓洗皆可達到清潔手心之效果。

2、推薦採「濕洗手(以洗手乳或肥皂)」擦乾後，再以「酒精」乾洗手；
若在外水源不便，以酒精清潔的效果也很不錯。

3、推薦「1.8公克」為較佳的洗手乳質量。
→設計高度0.4cm的C型環，約為原設計的2.3倍，抗菌效果更佳且實惠節約。

4、以純洗手乳洗手的清潔濃度最佳；
若有加水稀釋之需求，建議可用D組濃度(洗手乳：水=1：2)。

5、洗手液放置25天後以 D組濃度(洗手乳：水=1：2) 及 C組濃度(洗手乳：水=1：1)
的抗菌效果較佳。

6、在清潔環境上，不論清潔液種類皆具有抗菌效果，其中以酒精為最佳。

結論



一、蔡尚芳等人（2020）。國民中學自然科學課本第二冊。新北市：康軒書局。
二、吳有恩（2020）。天洛神兵，黴軍止步～洛神葵對黴菌生長影響的研究。

中華民國第60屆中小學科展覽會。未出版。
三、王濰平、王瀚德（2020）。綠豆發芽水抑制黴菌效果之探討。2020年臺灣

國際科學展覽會。未出版。
四、康健編輯部，疫 情緊張！陳時中籲隨身帶酒精 正確使用一次看。檢自

https://www.commonhealth.com.tw/article/83552 (20210322)
五、生活誌，防武漢肺炎、流感病毒，洗手你有洗對嗎？正確步驟該這樣做！。

檢自https://blog.icook.tw/posts/142759 (20210322)
六、關鍵評論，感染科醫師：洗手口訣「內外夾弓大立腕」，洗完手沒擦乾等於

做白工。檢自https://www.thenewslens.com/article/46617 (20210322)
七、維基百科，真菌。檢自

https://zh.wikipedia.org/zhtw/%E7%9C%9F%E8%8F%8C  (20210322)

參考資料

簡報結束，感謝聆聽


	032910-封面
	032910-本文
	摘要
	壹、研究動機
	貳、實驗目的
	參、研究設備及器材
	肆、研究過程或方法
	伍、實驗結果
	陸、討論
	柒、結論
	捌、參考資料及其他

	032910-評語
	032910-簡報



